
line.htm)  One of these 
tools is the command 
“netstat”, which  has a 
number of features for 
analyzing network traf-
fic.  More experienced 
users can read about 
using “netstat” for de-
tailed network analysis 
at 
(http://commandwindo
ws.com/netstat.htm) . 
 This tip shows a quick 
and easy way to use 
"netstat" to see what 
programs are connect-
ing to the Internet: 

1. Open the command 
prompt. For this tip, 
Windows Vista/7 will 
require administrator 
privileges 
Enter “netstat -b” 
(without quotes) 

A  list of the executable 
files that are making 
connections to the In-
ternet will be displayed. 
You can also add a 
switch "n" to tell you 
which IP addresses are 
being contacted. Then 
step 2 becomes: 
            Enter "netstat -
bn" (without quotes) 

Anybody who uses the 
Internet has to be 
aware of the constant 
danger of being infect-
ed with malware that 
surreptitiously con-
nects to the Internet. 
Various kinds of spy-
ware and Trojan hors-
es can phone home 
and reveal your per-
sonal information.  
Or an infection may 
turn your computer 
into a zombie that is 
part of a botnet with-
out your knowledge. 
One way of guarding 
against unwanted In-
ternet activity is with a 
two-way firewall that 
monitors both incoming 
and outgoing traffic. 
However, many aver-
age PC users have a 
firewall that only 
checks incoming traffic. 
There are also a varie-
ty of programs for ana-
lyzing network activity 
but most  of these re-
quire a knowledge of 
networking that aver-
age PC users do not 
have. Fortunately, 
there are some simple 
ways that anybody can 
use and this tip will dis-
cuss one of these. It 

doesn’t require any-
thing to be downloaded 
and installed and the 
information it provides 

is easy to interpret. It 
doesn’t replace more 
advanced methods but 
it makes useful infor-
mation available to us-
ers of all levels of ex-
pertise.  
Using the command 
“netstat” to check 
Internet activity 
All current versions of 
Windows come with a 
number of network 
tools that run from the 
command line. (How to 
use the command line 
is discussed at 
( http://www.techsuppo
rtalert.com/content/per
haps-most-under-
appreciated-tool-
windows-command-
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Mail merge over-
view 
In OOo there are lots 
of different ways to do 
mail merge. It took 
some trial-and-error to 
find the best methods 
for us, and that is what 
I will be describing 
here. The first choice 
to make is database 
format. Our reception-
ist had always used 
Excel spreadsheets as 
data sources for MS 
Word, so we first tried 
using OOo’s Calc 
spreadsheets. It turns 
out that this choice 
leads to several limita-
tions. For example, if 
you find a mistake in 
your data while you are 
doing the mail merge, 
you must return to the 
spreadsheet to fix the 
mistake, then com-
pletely close OOo and 
open it again before 
continuing the merge. 
Also, each spread-
sheet must be set up 
as a new data source. I 
then ran across a sug-
gestion to use dBASE 
files, which have been 
the perfect solution. 

We found the 
dBASE file format 
to be the perfect so-
lution for everyday 
mail merge tasks  
We also made the de-
cision to avoid the nor-
mal mail merge tools 

provided in OOo 1.1, 
which evolved into the 
Mail Merge Wizard in 
2.x. While the wizard 
may be good for limited 
cases, it does not han-
dle the variety of mail 
merge tasks we need-
ed. It is actually fairly 
simple to go through 
the steps manually 
once you get used to 
them. 

Creating data 
sources 
The first step in prepar-
ing for any mail merge 
task is to set up your 
data source. If you will 
be doing a lot of mail 
merge with a lot of data 
sources, it is appropri-
ate to plan ahead how 
your files will be laid 
out. Our receptionist 
has a directory for 
each department. 
When using dBASE 
files as your data 
source, you only need 
to set up one data 
source for each direc-
tory (as will be ex-
plained later), and can 
add and remove files 
as needed. If you are 
working with existing 
data, you can probably 
convert it by opening it 
in Calc and saving it as 
a dBASE file. This 
works for spread-
sheets, comma-
delimited (CSV) files, 
and any other filetype 

that Calc will open. In 
the first row of the file, 
specify field names. A 
limitation of dBASE 
files is that field names 
can only be ten charac-
ters—Calc will shorten 
whatever you put in to 
this length. You may 
also wish to specify the 
field type and length. 
Character fields may 
be specified as 
“FIELDNAME,C,10”, 
and dates may be 
specified as 
“FIELDNAME,D”, while 
numeric fields may be 
specified as 
“FIELDNAME,N,4,2”. 
On numeric fields, the 
first number is the 
length allowed before 
the decimal, and the 
second number is the 
number of digits stored 
after the decimal. If you 
do not specify these, 
Calc will determine the 
proper values based 
on the data in the col-
umn. I recommend that 
you specify zip codes 
especially, either as 
character or as number 
with no digits after the 
decimal, so you won’t 
receive any surprises 
when you merge. 
When you save the file, 
Calc will ask you to 
choose a character set. 
The default “Western 
Europe (DOS/OS2-
850/International)” has 
always worked for us. 
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After you have one or 
more dBASE files, it is 
time to set up your da-
ta source. From any 
OOo application, click 
on 
File→New→Database. 
You will be taken to the 
Database Wizard. On 
the first screen, select 
“Connect to an existing 
database”, and choose 
dBASE as the type. On 
the next screen, either 
click on Browse and 
locate the directory 
where you stored your 
dBASE files, or type in 
the full path of the di-
rectory. Again I empha-
size, you only point to 
the directory, not to an 
individual dBASE file. If 
you use the file brows-
er, click OK when you 
are in the directory with 
the dBASE file(s). On 
the final screen of the 
wizard, leave the de-
fault to register the da-
tabase, but probably 
turn off “Open the data-
base for editing”. When 
you click Finish, you 
will be presented a 
Save dialog. I refer to 
the file saved here as a 
database connection—
it contains only the in-
formation for OOo to 
access the data, not 
the data itself. Give it 
an appropriate name 
and save it wherever 
you wish. I prefer to 
designate a single di-

rectory for all of these 
files. 

OOo database con-
nections point to a 
directory of dBASE 
files, not an individ-
ual file  
You can verify that the 
data source is set up 
properly by opening 
either Writer (the word 
processor) or Calc, 
then selecting 
View→Data Sources 
(or pressing F4). The 
document portion of 
your window will split 
vertically. You will see 
a list of your data 
sources on the left side 
of the top area). If you 
click on the + next to 
the name of your new 
data source, and on 
the + next to Tables, 
and on the name of the 
dBASE file, you will 
see your data on the 
right side. From this 
view you can edit the 
data, as well as add 
and delete records. 

Using mail merge 
for letters 
Now it is time to put the 
data to use. Open Writ-
er and start your form 
letter. You may either 
type your entire letter 
first and then add the 
fields to be merged, or 
you may add the fields 
as you go. There are 
(at least) two ways to 
add fields. Using 

View→Data Sources, 
you may click on a col-
umn header (field 
name) and drag it to 
the letter in the spot 
where you want the 
field. Our receptionist 
did not care for this ap-
proach because she 
did not have as much 
control over where the 
field ended up, could 
not view as much of 
the letter at a time with 
the data view at the 
top, and had no control 
over formatting of num-
bers, dates, etc. The 
other method is to 
place your cursor 
where you want the 
field, and go to In-
sert→Fields→Other…, 
which opens the Fields 
dialog box (see figure 
2). Go to the Database 
tab, and click on “Mail 
merge fields” on the 
left, then open up your 
table on the right and 
select the desired field. 
If any special format-
ting needs to be ap-
plied, use For-
mat→User-
defined→Additional 
formats… (if neces-
sary) at the bottom. 

Using Open Office Mail Merge (Continued) 
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Applies to Windows 
XP / Vista / 7. 
 
One well-known Reg-
istry edit may be ap-
propriate during any 
season when many 
will be getting new 
computers.  
When you give away 
or sell your old Win-
dows machine, you 
will want to change 
the name of the Reg-
istered Owner (not 
necessary if you 
have wiped off the 
operating system, of 
course).  
This is easily done in 
the Windows  

Registry with the 
Registry Editor. Ad-
ministrative privileges 
are required. Here is 
the procedure: 
1. Open Regedit 
Using Regedit, navi-
gate to the following 
registry key: 
HKEY_LOCAL_MAC
HINE\SOFTWARE\M
icrosoft\Windows 
NT\CurrentVersion 
 
2. In the right pane, 
double-click 
"RegisteredOwner" A 
window “Edit string” 
will open. Under Val-
ue data, type the 
name that you want. 

Click “OK” 
 
3. Close Regedit 
An alternative to step 
2 is to use the Find 
function  
Enter 
"registeredowner”  
(without quotes) in 
the “Find what” line 
(as shown in the 
graphic below).  
Click "Find Next" and 
then proceed as indi-
cated in steps 3-6 
above. 

the Full Release (With 
PNG) in your choice of 
compressed file ar-
chive. 
4 Download the file. 
5 Once the download 
is completed, extract 
the file. 
6 Launch OpenOffice 
Writer, and under the 
top menu, go to 
"Tools>Gallery". 
7 You can move the 
gallery to the left or 
right like any other 
toolbar. You can also 
switch from icon view 
to detailed list view. 
8 Click to create a 

OpenOffice.org is a 
great, free, office suite. 
Sadly, it does not come 
with a great clipart se-
lection. It can, howev-
er, be added free of 
charge. 
Steps 
Note: this will work on 
all platforms and in all 
versions of OpenOf-
fice.org 
2 Go to the Open Clip 
Art Library's download 
page http://
www.openclipart.org/
packages in your web 
browser of choice. 
3 Select for download 

"New Theme" in the 
window that has come 
up. 
9 On the dialog, click 
on the right tab. 
10 Click to "Find Files". 
Click on the folder cre-
ated from the extract-
ing of the files. 
11 Now click to "Add 
all"  
12 Now press the "OK" 
button at the bottom of 
the dialog. 
13 Now you can enjoy 
wonderful clipart in 
Openoffice. 
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Do you have a personal folder where you would like to put files that you download but your browser 

keeps putting them somewhere else? All the common browsers have a default location that may not be 

what you had in mind. In this tip, I’ll tell you how to send downloads where you want in three of the most 

popular browsers. Except where noted, information applies to Windows XP, Vista, 7. 

Select a download folder for Firefox 3.6+ 
Firefox uses a folder in My Documents in Windows XP or the %USERPROFILE%\Downloads folder in 

Windows Vista/7 as a default. Changing the download destination is easy: 

1. Go to the “Tools” menu 

2. Select “Options” 

3. Click the “General” tab 

4. In the section labeled “Downloads”, choose your location from the “Browse” function (see the figure 

below) 

Click  “OK” and “OK’ again

 
Select a download folder for Google Chrome 8 
Chrome also has an easy way to configure the setting for the download location. 

1. Click the “Tools” icon (the wrench) 

2. Select “Options” 

3. Click the tab “Under the Hood” 

4. Scroll down to the “Downloads” section (see the figure below) 

5. Use the “Browse” function  to select your folder 

6. Click “OK” 

Click “Close”

 
Internet Explorer 8 
There is no direct setting in IE8 to change the download folder. Advanced PC users can edit a value called 

“Download Directory” in the following Registry key: 

    HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer 
However, several Windows tweaking programs provide for changing the download location. The Ultimate 

Windows Tweaker  http://www.thewindowsclub.com/ultimate-windows-tweaker-v2-a-tweak-ui-for-

windows-7-vistaAnd there you have it. Now you can put downloads wherever you choose. 

How to Get Your Browser to 
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Computer Help Group 

 Joe Zagar  480-373-9373  all systems and programs 

 

911 Call to help group 

What it costs elsewhere 

Geek Squad in home call $149.00 per hour 

Serving Online Seniors in home call $85.00 per hour 

On line help $79.95 subscription + $24.95 per month 

a gratuity to your SVECC helper is recommended  

 

Name _________________________________________________Phone__________________________ 

Address _______________________________________________________________________________ 

Brief problem description 

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________ 

Group Leader Joe Zagar 

Depending on the season we have a number of helpers to assist with problems or 

installations. Contact Joe Zagar for assistance, referral, or recommendation of local 

service provider. 

In addition on most Tuesdays from October to March we offer a fix-it session from 

1pm to 3pm at the Training Center. Sessions are open to all residents of SVE and 

are first come first serve. Charge is $15.00. 

Call ahead to see if your problem can be solved at a Tuesday session. 
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Computer Tips 
 

Windows 7, as a multi-tasking operating system, allows us to open lots of 

'windows' which can completely take over the Desktop. 

 

Clicking the minimize or close button for each open window is one way to clear the 

open windows that you don't need at that moment, but Windows 7 allows you to 

'shake away' all of the open windows except that one that you want to work with! 

 

All you have to do is click and hold the right-mouse button at the top of the desired 

window and shake it back and forth...et viola! 

 

BONUS TIP: if you want them all to come back up, simple shake the window again! 



Founded for the Residents of  

Sunland Village East 
Mission: To help each other learn about Computers 

Membership is open to all residents of SVE 

Dues are $20.00 per Year 

Due October 1st 
 

Paddy was driving down 
the street in a sweat be-
cause he had an important 
meeting and couldn't find 
a parking place. Looking 
up to heaven he said, 
'Lord take pity on me. If 
you find me a parking 
place I will go to Mass 
every Sunday for the rest 
of me life and give up me 
Irish Whiskey!'  
 
Miraculously, a parking 
place appeared. 
 
Paddy looked up again 
and said, 'Never mind, I 
found one.'  

 

 

 

Paddy was in New York . 
 
He was patiently waiting 
and watching the traffic 
cop on a busy street 
crossing. The cop stopped 
the flow of traffic and 
shouted, 'Okay, pedestri-
ans.' Then he'd allow the 
traffic to pass. 
 
He'd done this several 
times, and Paddy still 
stood on the sidewalk. 
 
After the cop had shouted, 
'Pedestrians!' for the tenth 
time, Paddy went over to 
him and said, 'Is it not 
about time ye let the Cath-
olics across?'  

 

 

An Irish priest is driving 
down to New York and 
gets stopped for speeding 
in Connecticut . The state 
trooper smells alcohol on 
the priest's breath and 
then sees an empty wine 
bottle on the floor of the 
car.  
 
He says, 'Sir, have you 
been drinking?' 
 
'Just water,' says the 
priest. 
 
The trooper says, 'Then 
why do I smell wine?' 
 
The priest looks at the 
bottle and says, 'Good 
Lord! He's done it again!'  

Irish Stories  
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